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1. Introduction

Overview
Mailstrom is an electronic mail program for Macintosh computers that
allows you to read and send messages to other users of electronic 
mail. You can send mail to—and receive mail from—any kind of 
computer that is connected via networks and runs the appropriate 
software. Messages are called mail and are stored in “mailboxes.” You
have access to your own personal inbox mailbox, as well as other 
mailboxes you may have created or for which you have permissions. 
You may also create additional mailboxes to store your mail.

Features
Mailstrom features all the user-friendly, graphically oriented qualities 
of the Macintosh as well as most conventional mail-handling 
capabilities, plus:

• an Address Book to facilitate creation of personalized mailing 
lists

• a "Finger" facility to get information (from .plan files) about 
users

• a Custom Reply mechanism that allows you to send pre-written 
replies from a menu

• the ability to create new mailboxes on-the-fly
• the ability to open multiple mailboxes simultaneously
• an easy-to-use mail composition interface which allows message:

• composing 
• replying 
• forwarding

• facilities for moving, copying, browsing, marking and flagging 
messages

• a find facility that allows easy retrieval and browsing of 
messages by various query criteria—e.g., date ranges, subject or
header contents, to/from addresses etc.

• the ability to save frequently-used find criteria for future use
• user customization
• Balloon Help for those who use System 7



Conventions of this Document
Keystroke Commands
Whenever available, keystroke commands are represented 
parenthetically. For example:
“With the read window open, choose Unwrap Text (Command-D) 
from the Message menu.”

Menu Options
Menu options are represented in bold type, e.g., “From the File menu 
select Save as…”

Italic Text
Italic text is used for the titles of books or to give special emphasis as 
in when a new, potentially unfamiliar term is introduced. 
For example:
“A remailed message will include the header information from the 
original message…”

On-line Help
Topic Help
Mailstrom offers on-line help for some of the more relevant electronic 
mail topics. To use Help,

1. From the Apple menu, select Help.

2. From the submenu, select the topic that may be of assistance to 
you.

Balloon Help
If you're using System 7, you can use Balloon Help to display brief 
descriptions of many menu commands, icons, and other items on the 



screen. Refer to Apple Macintosh documentation to learn more about 
Balloon Help.



2. Getting Started

Launching Mailstrom for the First Time
You should have two files installed on your Macintosh—one called 
Mailstrom (the application) and one called Default Profile (the 
preferences file). 

1. Launch the Mailstrom application by double-clicking on either the
application or the Default Profile icon. 

 

The first time you launch Mailstrom the Preferences Window will 
open. The Preferences Window allows you to personalize your 
communications environment by setting user preferences. 

2. If you are eager to begin using Mailstrom, all you need to do 
immediately is change the Names preferences. The instructions 
that follow will show how to do this. For a full description of your 
preference options, see Appendix A.



Your Name: This is your name as you would like your e-mail 
correspondents to know it. Correspondents will see this name 
appended at the beginning of your Acct. name, for example 
Geraldine Raffe in: <Geraldine Raffe> 
graffe@bigserver.podunku.edu

EMail Address is the address people need to use to send mail to 
you, e.g., graffe@bigserver.podunku.edu

SMTP Host: is the network server responsible for putting your 
mail out on the Internet. This may be the same server on which 
your account resides.

IMAP Host: is the server that maintains your mailbox. Two IMAP 
host fields are available so you can enter an alternate host in the 
event your primary host is not available at login.

Fill in the boxes appropriately. You may want to consult your 
system administrator to see what the proper host names are. For 
example:

When you are done, click on the OK button. These preferences 
are automatically saved to the current preferences file (profile). 
Alternatively, you can save your preferences (at any time during 
the current mail session) as a new file by choosing Save 
Preferences As… from the File menu.



3. If you are using Mailstrom for the first time (and with the default 
profile distributed with this program), the Open Mailbox dialog 
box will open automatically. (If you are using someone else’s 
preference file, you must select Open Mailbox… from the 
Mailbox menu.

4. To open your inbox on the host server specified in your 
preferences, click the OK button. Your inbox is the mail file where
mail is originally sent. Some people choose to file their messages 
into alternative mailboxes (aka mail files). 

Later we will show how to store information (mailbox and host 
names) so one can easily access mailboxes other than the inbox 
(see “Creating a New Mailbox File”).

5. In the dialogue box that now appears, Mailstrom will have filled in
the account name from the information it has in the current 
preferences. Type in your password. As you type your password, it
appears as large dots so anyone who happens to be looking can’t 
read it. After you are done, click on the OK button. 



The Browse Window

When you open a mailbox, a browse window will open, whichwill look 
something like this:

The browse window title tells you the name of the mailbox, how many 
messages it contains (and optionally the host on which the mailbox 
resides). The browse window lists all the messages in the order they 
were added to the mailbox. The message headers tell you the date 
each message arrived, who sent it, what it’s about, and whether 
you’ve done anything with it. At the beginning of a mail session, new 
messages will appear in reverse-video, i.e., they are selected.

Message Status Letters
The letters next to the message header tell you what you’ve done with
each message. The message status letters and their meanings are:
N - New
R - Read
A - Answered
D - Marked for deletion
F - Flagged
U - Unseen 



Command Bar
The following is a brief explanation of the operations facilitated by the
command bar. The various mail operations are explained in more 
detail in later sections (consult the table of contents or the index).

 Read selected messages.

Set or clear flags of the selected messages. The flag icon has a 
downward arrow, indicating that clicking the mouse on it bring 
up a pop-up menu of choices. These include four standard 
"system" flags: Seen, Recent, Answered and Flagged, as well as 
any user-defined keywords assigned to your mail service. 
For further explanation of keywords, see Appendix D.

Transfer messages to a different mail file.

Print selected message(s).

Delete selected message(s). 



3. Mail Operations

Selecting Messages
To read, delete, file or otherwise perform an operation on an e-mail 
message, the message must first be selected. Selected messages 
appear in reverse-video in the browse window. When you first open a 
mailbox and you have new messages, they will automatically be 
selected in the browse window. A message is also “selected” when you
are reading it (and the read window is active).

Selecting One or More Messages
To select one or more messages:

a. Click in the browse window on the message(s) you wish to 
select. 

b. Shift-click (or shift-click and drag) to select multiple messages.
c. Drag across a range of continuous messages.

When multiple messages are selected in the browse window, you can 
perform operations on all of them simultaneously, e.g., flag them (for 
attention later on), mark them for deletion, or file them, etc., using 
the command bar, or menu- or key commands.

Unselecting Messages
To unselect a message in the browse window, shift-click on the 
selected message.



Reading Messages
To open and read one or more messages, you can:

• double-click on a single message in the browse window
• click on the eye icon from the command bar, or press the Return

key, to read a sequence of selected messages
• hold the Option key and click on the eye icon (or press the 

Return key) to read a concatenation of selected messages, i.e., 
all the messages selected appear in the same window.

• choose First, Previous, Next or Last from the Message menu (or 
type Command 1 through 4).

• select one or more messages and type Command-J to read 
successive messages

inform

The window title includes the 
author's name and the subject.

The button bar features buttons for (from left to 
right) moving through a message sequence, 
flagging, filing, printing, marking for deletion 
and returning to the mailbox window.

The Replies menu offers various 
ways of responding to messages.

The status box tells you which 
message you're viewing of the ones 
you've selected.

The zoom box toggles between a 
"standard" window size and the size 
saved in your preferences.

A Read Window



Opening a Single Message
After opening a single message, a read window will appear. The text 
part of the read window displays two parts: the header and the body. 
You may see an abbreviated version of the header information or the 
literal or full text of the header (contains full routing information and 
more)—depending on your setting for Show Full Headers (found in the
Preferences window, Message Pane). 

Show Header Command
Mailstrom allows you to see the full header information including all 
routing of the message you are reading, regardless of your 
Preferences settings. With the read window open, choose Show 
Header (Command-H) from the Message menu.

Unwrap Text Command
When reading a message, Mailstrom will allow you to override the 
convention of 80 character lines, common in electronic mail. With the 
read window open, choose Unwrap Text (Command-D) from the 
Message menu. This will strip out carriage return characters and 
rewrap the text to the current window size. This is useful if you want 
to use a window size smaller or larger than 80 characters and have 
the message displayed cleanly, or if you want to copy some or all of 
the text to a word processor or other application and have automatic 
text wrapping. 



Reading Multiple Messages in a Single Read Window
After selecting multiple messages in the browse window, press the 
Return key or click on the eye icon in the command bar. A read 
window will open. When you have multiple messages selected, a read 
window will allow you to navigate forward or backward within the 
selected messages using either the left and right arrows in the 
command bar or by using command key equivalents. The command 
key equivalents include:

Command-K
(Delete)

(or clicking on the trashcan icon) marks the 
current message for deletion and displays the 
next message in the browse window

Command-J
(Read Next) 
Selected 
Message

(or clicking on the flag icon) will flag a message
and bring up the next selected message

Command-1 displays the first message in the read window
Command-2
(or Left Arrow)

displays the previous message in the read 
window

Command-3
(or Right Arrow)

displays the next message in the read window

Command-4 displays the last message in the read window

If you have them on your keyboard, the PageUp, PageDown, Home, 
and End keys scroll the text in a predictable fashion. Because not all 
keyboards have these keys, the up and down arrows will also page the
text.
When you are on the last message, the right arrow will become a 
return arrow. Pressing the return arrow will return you to the browse 
window.

Viewing Multiple Messages In Separate Windows
You can view multiple messages in separate windows by simply 
opening additional messages from the browse window. 

Closing a Read Window
When you are through reading a message, you can simply close the 
window by clicking on the “close window” box in the upper-left of the 



read window or choosing Close Window  from the File menu 
(Command-W).



Replying to Messages
You may wish to respond to the author of a message and potentially 
those copied on it. Mailstrom has several facilities for responding to 
messages, including:

• replying to the sender
• replying to all (including those carbon-copied (cc'ed) on 

message)
• replying to the sender and those cc’ed but not you
• custom replying to the sender
• forwarding
• remailing (distinguished from forwarding below)

Reply to Sender, Reply to All, All But Me
To reply to a message, select Reply to Sender, Reply to All, or All 
But Me from the Replies menu. A Reply window will open, already 
addressed, with a subject header in brackets and including the 
message and header information of the message to which you are 
responding.

Forwarding a Message
To forward a message, select Forward from the Replies menu 
(Command-[).

A Forwarded Message window will open, already addressed, with a 
subject header in brackets and including the message and header 
information of the message to which you are responding.



Remail
Remailing a message is slightly different than forwarding. A remailed 
message will include the header information from the original 
message, and thus the remailed message may appear to be sent by 
the originator of the message rather than by you, though a special 
“resent” header is included to indicate who remailed the message. By 
convention, you should not edit a remailed message because it is 
considered to be a misrepresentation of the original author (but this 
convention is not enforced by this program). To remail a message, 
select Remail (Command-]) from the Replies menu.



Custom Replies
Sometimes you may find yourself sending the same messages 
repeatedly. Mailstrom provides a facility to re-use prepared responses.
You may define up to five such reply messages. 

Creating Custom Replies
To create a new reply or to edit an existing one, follow these 
instructions:

1. Choose Custom Replies… from the Replies menu in the read 
window.

2. The Custom Replies dialogue box will appear. To create a new 
reply, type in the name of the message, the message content, and 
indicate whether or not you would like to have the opportunity to 
edit the message before it is sent (Send w/o Edit). To edit an 
existing message, use the Previous and Next buttons to navigate 
to the designated message. Then click on OK.



Using Custom Replies
To use a custom reply, simply select the reply from the Replies menu 
in the read window (in the example below, the Thanks reply is 
selected). 

Inserting Original Message Text
Occasionally, in a reply or other message you may want to include text
from another message. In electronic mail, it is common in such cases 
to distinguish the inserted text by preceding it with a right angle 
bracket (>). Because copy and paste are commonly understood, 
Mailstrom allows you to copy from any received message and paste 
into any outgoing message. To set off the inserted text with right 
angle brackets when pasting, hold the Shift key down while selecting 
Command-V. Mailstrom facilitates several ways to insert text:

A. Insert the Entire Message in a Reply
If you wish to insert the entire original message in your outgoing 
message:

1. With your reply window active, select Insert Text (Command-D) 
from the Message menu.

B. Insert Part of Message in a Reply
If you wish to insert parts of a message in your reply window, you may
use two methods:

1. With the original message open, select a section of text that you 
wish to appear in your reply.

2. From the Replies menu in the current read window, select the 
type of reply you want, e.g., Reply to All. 



The reply window will contain the text you selected set off by 
“greater than” signs (>). You can then add your own commentary 
to the message. 



Composing a Message
1. From the File menu, select New Message (Command-N). An 

Outgoing Message window will appear, with the cursor blinking in
the To: address field.

2. Type in the address(es) of the person(s) or group(s) to whom you 
wish to send the e-mail message. Separate each addressee with a 
comma.

3. Press the tab key to advance to the subject field and write a brief 
summary of the message. The subject description is very useful to 
correspondents.

The CC (carbon-copy) field allows you to include others who are 
not necessarily the primary recipients. The BCC (blind carbon 
copying) allows you to copy the message to yourself (or others) 
without this name appearing in the address list that recipient 
receive.

4. To begin to enter text in the message, either advance the cursor 
using the tab key or simply click in the message field. Type in 
your message. You can edit anything in the message (including 
the subject and address) by positioning the cursor and employing 
Macintosh editing techniques (this means you can cut and paste 
from other mail or text documents; you cannot paste graphics—
yet).

5. To send a message, select Send from the Message menu 



(Command-/),  or press the Enter key, or click on the  Send 
button in the message window.



Finding Text Within a Message Window
You can search for a text string within an individual message window 
(for information about locating text string within a mailbox of 
messages see Finding Messages later in this document). 

1. With the message window open, select Find (Command-F) from 
the Edit menu. 

2. You can specify whether the search should start from the top of 
the message (the default is from the current insertion point) and 
whether the search should be case sensitive. If found, the text 
string will be highlighted in your message. If not found, Mailstrom
will beep.

3. To repeat the search, choose Find Again (Command-G) from the 
Edit menu.

Saving a Message Draft
Mailstrom allows you to save a draft of a message composition for 
later use. To save a message composition, select Save As… 
(Command-S) from the File menu. The message will be saved to the 
disk and folder you select in the dialogue box. Message drafts can be 
opened by most word processors.

Appending a Message to a Text File
Mailstrom also provides a command to append the current message 
text onto an existing file. This is commonly used in constructing files 
that record a conversation or sequence of messages. To save the 
current message at the end of a file on your Macintosh, from the File 
menu, choose Append Text…



Opening Text Documents
Mailstrom allows you to open text documents (draft mail messages, 
TeachText, Microsoft Word text documents, etc.) and copy and paste 
from them into your message composition. From the File menu select 
Open Text…(Command-O) and then select a text document. 

If the text file was created by saving the contents of one of 
Mailstrom’s Outgoing Message windows, the address will be 
reinserted into the appropriate address fields; otherwise, the address 
will be blank.



Addressing

Addressing Within an Organization
Conventionally, within an organization (such as Stanford University) 
messages are addressed in the form: username@host. For example:
fred@large

Addressing Within a Host
If the user has an account on the default host, i.e., the one specified in
the Preferences file, then he need not specify the host name for 
recipients who are also on that host. Messages can be addressed in 
the form of the user name of an individual or the name of the group. 
For example:
shortliffe
msob-help

Outside of Organization
To send e-mail to colleagues at other organizations it is necessary to 
include the fully qualified address. To send e-mail via the Internet, the
conventional format to employ is username@host.domain, where the 
domain contains the name and type of organization and may include 
many subdivisions. For example:
robinson@eos.arc.nasa.gov

Multiple Addresses
You can list as many recipients as you like by separating each one 
with a comma. 

Address Book
Mailstrom allows you to create your own mail distribution lists which 
can be used to expeditiously address message to frequently-mailed 
recipients. 

Creating a Distribution List
To create a distribution list, first select Address Book from the 
Windows menu. A dialogue box appears. Type in the addresses of 
your distribution list in the Address field (offset by commas), then type
in the name of the distribution list in the Name field. Finally, click on 



the Add button to add the list to the selectable selections.



Using the Address Book to Address a Message
There are three different ways to use the Mailstrom address book:

1. Select Address Book from the Windows menu, select the list of
choice, and click on the Send button. A pre-addressed mail 
composition window will appear. All entries in the list will 
appear in the To field.

2. With the Address Book open, drag a distribution list from the 
Address Book and drop it in an address field of a composition 
window. The list will expand.

3. In a composition window, simply type in an address field the 
name of the distribution list. Upon sending, the list will be 
expanded. If you wish to see the list expanded, you may view this
in the Status Window.



Finger
Mailstrom provides facilities to query network databases for 
information about users. The finger facility will ask a specific host for 
information.  By default, finger displays information about each 
logged-in user, including his or her: login name, full name, terminal 
name, idle time, login time, and location if known. Finger can also be 
used to expand mailing lists. From the Edit menu, select Finger 
(Command-L) and type in the username and host in their repective 
fields. Then click on the Finger button.. 

The results of a finger search might look something like this:



Some institutions provide a wide area database search capability 
that does not require you to specify a particular host. This is 
called a whois database search. In Mailstrom, one types in the 
user name and clicks 



on the Whois button. Mailstrom sends a request to a specific host. 
The whois host is a resource of Mailstrom and should  be assigned
to the by your system administrator. (See Appendix E, Editing 
Mailstrom’s Resources)

It is sometimes useful to find out information about who is on a 
mailing list. For that purpose, Mailstrom’s finger facility may also 
be used to expand a distribution list. In the example below, we 
find out who is in the list called “dialect.”

The results might look like this:



Flagging Messages
Flagging messages is a way of drawing attention to them. You might 
want to flag a message, for instance, if you think it needs a response 
but you don’t have time right now. If you flag the message(s), later 
you can select these messages and respond to them. To flag messages:

1. Select the message(s) you wish to flag.

2. From the Command bar select the Flag icon (or from the 
Message menu, select Flag (Command-J)). The message(s) will 
be marked with an F in the browse window. 

Selecting Flagged Messages
To find flagged messages, you can either scroll through the browse 
window and look for F’s next to message headers or you can use the 
Find… mechanism to select all flagged messages (see “Finding 
Messages” later in this document).

Printing Messages
Mailstrom supports the printing of both Read and Compose windows. 
To print one or more messages:

1. With any read or compose window active, click on the Print button
in the command bar. 

Alternatively:

1. Select the message(s) from the browse window.

2. From the File menu, select Print…(Command-P).

3. Fill in the print dialogue box and click the OK button.

Deleting and Expunging Messages
After reading a message, you may choose to get rid of it. This requires
two actions: 

1) marking the message for deletion, and 
2) expunging it.

This two-step process helps guard against accidental removal of 
messages. 



Deleting Messages
To mark message(s) deleted, follow these instructions:

1. Select the message(s) you wish to delete.

2. Press the Delete key or from the Message menu, select Delete 
(Command-K).

In the browse window, a “D” will appear to the left of each message 
that is marked for deletion.
NOTE: You can only delete messages if you have “write access” to the 
particular mailbox you are working on. Instances where you may not 
have write access include:

• when you are accessing a mailbox that is setup for others to 
read, e.g., an archive of group messages

• when you are accessing the mailbox from a previously-started 
mail program (e.g., via Columbia mm). At present, you cannot 
have simultaneous write-access from two mail programs.

Undeleting Messages
Undeleting messages is like taking them out of the trash can before 
you do an “empty trash” operation on the Mac. To undelete a 
message, select Undelete (Command-K) from the Message menu. 
You can also use the trashcan icon in the command bar. If the trash 
can icon in the command bar is bulging, then clicking on the trashcan 
button will undelete the selected messages. If the majority of the 
selected messages are deleted, then clicking on the trashcan will 
undelete all the selected messages. Conversely, if a majority of 
messages are not marked for deletion, clicking on the trashcan will 
delete all of the selected messages.

Expunging Messages Marked For Deletion
Expunging messages is analogous to “emptying the trash.” To remove 
messages marked for deletion, select Expunge (Command-E) from 
the Mailbox menu.
CAUTION!: Expunging is not reversible! Make sure the message(s) 
you are about to remove are appropriate for removal. Optionally, you 
can request a confirmation before any expunge is performed. See 
“Appendix A: Preferences” for details.



Expunging Upon Closing of Mailbox
You can also, as an option, request Mailstrom to perform an Expunge 
on a mailbox, whenever you close it. See “Appendix A: Preferences” 
for details.

Finding Messages
Mailstrom features a Find utility to locate one or more messages in a 
mailbox. Follow these instructions for using Find.

1. Select Find (Command-F) from the Edit menu. The find dialog 
box will appear (see below). The left side of the box allows you to 
define a search pattern. The scrolling list on the right side of the 
window lets you edit, reuse or remove saved selection criteria. 

2. Type in the criteria. Select search fields from the pop-up menus, 
enter text or numbers (dates) in the text fields, and/or select flags 
from the flags pop-up menus. 

In the example below, Mailstrom is instructed to find all messages
in the current mailbox that contain the expression “wr-help” in 
the To field of the message header and that are flagged as 
unanswered1* 

3. When done, click on the OK button to begin the search. 

1* In fact, unanswered means not having the flag “answered.”



NOTE: If you wish to include the current selected messages with 
the search results press the shift key simultaneously and then 
click on the OK button.

When the search is done, the status window will indicate if 
messages were found. Messages meeting the criteria will appear 
in reverse-video in your mailbox browse window. You may have to 
scroll through the window to see them all or you can press the 
Return key to read them.

Saving a Set of Find Criteria for Re-Use
To add a re-usable set of Find criteria to the scrollable list, define the 
search criteria (as above), type the desired name into the Save 
criteria as: field, and press the Add button.

Once you have added a set of find criteria to the list, you do not need 
to return to this dialog box to invoke it. You will also find your list of 
criteria stored in the Find command bar of the browse window (see 
below).



Removing a Set of Find Criteria
To remove a set of Find criteria from the scrollable list, select that 
entry in the list and click on the Remove button. To select multiple 
sets of criteria, shift-click to select a range or Command-Click to 
select an arbitrary set. Then click on the Remove button.

Editing a Set of Find Criteria
To edit a set of Find criteria, select a single entry, edit the text fields 
and pop-up menus, then press the Add button. This will overwrite the 
existing list entry (without confirmation).

Using Multiple Sets of Find Criteria
To select all messages that satisfy any one of many criteria (also 
called a disjunctive search), select multiple entries in the scrollable 
list and press the OK button. To select contiguous entries in the list, 
shift-click. To select non-contiguous entries, command-click. 
In the example below, for instance, the results might be messages that
contain the word ‘documentation’ or that are from Tom or contain the 
text string ‘Information Retrieval.’

Subview Windows for Iterative Searches and Easy Viewing
Sometimes a search may return too many positive hits. In this case, 
Mailstrom provides the ability to apply increasingly constraining 
searches on the selected messages in a separate window, called a 
subview browse window. 



To create a subview browse window: 
Select any group of messages (this could be the result of a find) and 
double-click on the status area (bottom left corner of the browse 
window), or alternately, type Option-B. This will open another browse 
window, whose content is the current selection in the main browse 
window. 
A browse window can have any number of subview windows, each 
representing an independent set of messages, and subviews can have 
their own subviews. Changes to any message are reflected in every 
subview which contains that message. Subview windows are 
automatically closed whenever their parent browse window closes, or 
when an expunge is performed.



Transferring Messages
Sometimes you may wish to file messages for later use. Mailstrom 
allows you to transfer messages to existing mailboxes (files) or to new 
mailboxes that you create from Mailstrom. You can create as many 
mailboxes as your server will permit.

Copying vs. Moving
When you transfer messages, you have the option of either copying or 
moving. Copying a message to another mailbox retains the original 
message in the current mailbox, while moving a message deletes it 
from the current mailbox. You can copy or move multiple messages 
simultaneously.

1. Select the message(s) to be copied or moved. 

2. From the command bar select the mailbox icon (or from the 
Message menu, select Transfer…

3. The transfer dialogue box will appear. This box allows you to copy 
or move messages by selecting a destination mailbox file from the 
scrollable list or by defining a new destination mailbox file on the 
spot. If a mail file exists at the path provided, the server will 
append the transferred messages onto that file. Otherwise, it will 
create a new file.



Creating a New Mailbox File
NOTES: Though you may have created mailbox files with other 
mail programs, they will not automatically appear in the 
Mailstrom scrollable list of mailboxes. You can add these 
mailboxes to the scrollable list, however. Any mailboxes you have 
previously created with Mailstrom (including those with the Open
Mailbox command) will appear in the list.2

1. With the transfer dialogue box open (see above), type in the 
destination path (unless otherwise specified, this file will appear 
in your (UNIX) home directory). Follow your file server’s file name
conventions in creating file names (if you use alphabetical 
characters with no spaces, your names should be OK).

NOTE: You may only transfer messages to files on the IMAP host 
specified in the Preferences file. That host name appears in the 
dialogue box.

2. Type in an alias name for the file and then click in the Add button 
to add it to the scrollable list of mailboxes.

2Assuming the same profile document was used. The mailbox list is 
saved in the Mailstrom profile document.



NOTE: If you move messages, these messages will be marked for 
deletion in the original mailbox (they will not be removed, 
however, until you expunge them).

Editing the Mailbox List

Adding a Mailbox to the List 
To add a mailbox (or mailbox alias) to the mailbox list, follow these 
instructions:

1. In the Mailbox List window, type in the mailbox name (sun.mail in 
the example below). Enter the complete UNIX path name if the 
mailbox is not in your home directory.

2. Type in the name by which you want to refer this in the Alias field 
(sun in this example).

3. Press the Add button to add your alias/mailbox to the list.



Deleting/Changing Mailbox Aliases.
To remove an alias from the mailbox list, select the alias name and 
click on the Remove button. NOTE: This does not remove the mailfile
from the server. The mailfile and its contents continue to exist—just 
not in the Mailstrom mailbox list. To change the name of an alias, 
select the alias name and edit it using standard Macintosh editing 
techniques and press the Add button.



Appendix A: Preferences
The Preferences windows in Mailstrom allow you to personalize your 
communications environment. These settings include:

• your personal name for outgoing messages
• font types, styles and sizes for different windows (read, 

compose, browse etc.)
• how often the server looks to see whether new mail has arrived

in the current mailbox
• the capability to remember where you like Mailstrom windows 

to appear on your screen
• whether your inbox opens when you start the Mailstrom 

application
• an option to have yourself or someone else automatically 

carbon-copied on every message you send
• and more

Preferences are stored in a Mailstrom profile document. The profile 
document also stores the contents of the address book, the set of 
Search commands available from the Find menu, the set of mailboxes 
available from the Open Mailbox… or Transfer… dialogues, the 
Custom Replies defined by the user, and several internal variables. 
Preferences can be changed while using the application.

Saving Multiple Profiles on the Same Machine
You may save as many profiles as you like on a machine. In this way, 
several users who share the same Macintosh can all use the program 
in a personalized way. In such an event, it is easiest if one launches 
the program by double-clicking on the profile document of their 
choice, 



Editing a Preferences File
1. From the Windows menu, select Preferences (Command-Y).

The Preferences window will open.

2. Click on one of the Preferences selections (Names, Mailbox, 
Message, Looks) to open that particular selection’s window.



The Mailbox Preferences Window
The mailbox preferences allow you to set a number of automated 
features. 

Toggle This Box 
On

Accomplishes This:

Open Inbox At 
Startup

Logs into your Inbox upon launching the 
application

Remember PasswordKeeps the most recently-typed password in 
memory for as long as the program is 
running. This password is never written to a
file or remembered in between executions.

Check for Mail Sets the timer for how often Mailstrom will 
go to the server and look for new mail. 
Mailstrom also checks on most every other 
mail operation (read message, etc.), so mail 
may be delivered sooner.

Confirm DisconnectsDisplays a dialogue box asking: “Do you 
want to close this mailbox?”

Confirm Expunges Displays a dialogue box asking: “Expunging 
will permanently delete these messages? Go



for it?”

Expunge On Closing Displays a dialogue box asking: “Do you 
want to expunge?”



The Header Filter determines the order and presence of the header 
fields when not viewing in Show Full Header Mode (described in the 
Message Preferences section below) By typing in "Subject From To 
CC", the user gets a four line header (assuming all of the fields are 
found in the message).  The Show Full Header option in the message 
menu toggles the use of the full header.



The Message Preferences Window
The Message Preferences Window allows you to change some features
for reading and sending messages, among other things.

Toggle This Box 
On

Accomplishes This:

Show Message 
Number

Displays message number in browse 
window(s)

Show Message 
Length

Displays message length in browse 
window(s)

Gray Deleted Msgs Grays messages that have been marked for 
deletion in browse window(s)

Bold Direct Msgs Displays in bold those message headers in 
browse window(s) addressed directly to 
owner of mailbox

Italicize Flagged 
Msgs

Italicizes messages that have been flagged

Show Full Headers Displays full header information in read 
window which includes, the To, From, Date, 
Subject fields as well as the full routing 



information. When this is not toggled, the 
information displayed is dependent on what 
is set in the Header Filter field of the 
Mailbox preferences window (described 
above).

Confirm Sends Displays a dialogue box asking: “Send this 
message?”

Close Upon Send Closes the composition window after the 
successful send command completes. This 
can be temporarily toggled by holding down 
the option key during the send.

Proceed After DeleteDisplays next selected message in read 
window after marking a message for 
deletion (by pressing the trash can icon, 
Command-K, or the delete key)

Save Sent Messages Save all sent messages to an Outbox that 
lives in the same folder as the profile (?? not
true, actually, the messages get stored on 
the top level of the System Folder). This file 
is a text file which can be opened with 
Mailstrom, TeachText and many other text 
processing applications.





Default CC and BCC  allow you to automatically carbon copy (CC) 
someone or Blind Carbon Copy (carbon copy someone without their 
name(s) appearing in the header field of any of the other addressees) 
When filled out in the preferences window, these entries will affect the
initial contents of the CC and BCC fields in the header of a Compose 
window. These fields can be edited at the time of message 
composition.

The Looks Preferences Window
The Looks preferences window allows you to the size and kind of font 
for various Mailstrom windows. This preferences window gives you 
control over whether to display the Status window and what kind of 
information to display in this window.

Toggle This Box 
On

Accomplishes This:

Show Status 
Window

Displays the Status Window which provides 
information such as: new message 
announcements, the time messages were 
sent, brief problem descriptions. What 
exactly is displayed in this window is 
partially a function of whether IMAP Status
and/or Show Diagnostics are toggled on.



IMAP Status Displays all IMAP activity in the Status 
Window.

Show Diagnostics Displays diagnostic information in Status 
Window. This information can sometimes be 
useful in determining the origin of an error.

Animate Msg. 
Transition

Read window contents slide from right to 
left when replaced with another message.

Play Sounds Announces new message (instead of system-
determined beep).

Require 
Monospaced Font

Uses standard-width font (Courier, Monaco) 
in read and composition windows. This font 
selection overrides any other font selections 
for these windows.

Standard Allows you to select a fixed-width font for 
use in Read and Composition windows when
Require Standard Font is toggled on. Only
fixed-width fonts are selectable from the 
Font pull-down menu. Size and style may 
also be selected from a pull-down menu in 
this box.

Read Msgs Allows you to choose the font, size and style 
for this kind of window.

Compose Msgs Allows you to choose the font, size and style 
for this kind of window.

Status Allows you to choose the font, size and style 
for this kind of window.



Status Window Types
The Status Window will let you know when you have new messages, 
when messages have been sent successfully and when problems 
occur. There are three display options for Mailstrom status windows. 

Simple Status Window
The simple Status Window displays basic information about your mail 
operations, It will inform you whether you have successfully logged in 
or not and when you have new messages.

The Show IMAP Status Window
The Show IMAP Status Window displays all IMAP activity including 
deletions, copying, moving, checking, when messages are found in 
searches, etc.  

Show Full Diagnostics
If this option is on, extra debugging and status information is 
displayed. 



The Names Preferences Window
The Names preferences window allows you to set the default user 
name and the SMTP and IMAP mail hosts.

Your Name This can be your legal name, nickname, nom-de-
plume or whatever.

Acct. Name This should be your account name on the IMAP 
host. Your Acct. Name and your host names are 
not necessarily identical. It is important that the
Account Name contains the full text of login 
name and domain address. 

SMTP Host This is usually your UNIX server name.
IMAP Hosts This is usually your UNIX server name.



Personalizing Your Copy of Mailstrom
If, for some reason, you want to personalize the information stored in 
the Mailstrom start-up window, this is how one does it:

1. From the Apple menu, select About Mailstrom… The Mailstrom 
start-up window will appear.

2. Press the Option key and click on the mouse (but not in the OK 
box). A dialogue box will appear with two data entry fields

3. Type in your name and organization, then click on the OK box. 
You can edit this information at any time by starting again from 
step 1.



Appendix B: Mailstrom and the IMAP Mail Model
Unlike many other Macintosh mail programs, Mailstrom allows you to 
read electronic mail that may come from any number of different 
kinds of machines—whether from the local computing environment, 
across the United States or from anywhere in the world. Mailstrom 
does not care whether your mail was created on a Sun™, a NeXT™, 
another Macintosh™; or another machine. This is because it can read 
any electronic mail that was sent using the same protocol, SMTP 
(Simple Mail Transfer Protocol). 
Mailstrom also uses another protocol, called the Interactive Mail 
Access Protocol (IMAP). This protocol is a client/server model of mail, 
wherein incoming mail is sent to a central machine called the server, 
where it is distributed to the appropriate mailboxes. Your mail always 
resides on the server. A mail client machine (such as your Macintosh) 
can access the mail on the server using a mail client program (such as
Mailstrom) typically over a local area network. Mailstrom is therefore 
known as an IMAP mail client program, or mail client for short. 
The server may be a machine running the UNIX operating system: 
however, when you use Mailstrom this will be almost completely 
transparent: you don’t have to know UNIX commands to read your 
mail .
Because your mail resides on a server, it can be read with other mail 
applications as well. There are mail clients on SPARCstations™, 
NeXTs, Explorers™, etc. so you can read the same mail on these 
machines as you do on your Macintosh with Mailstrom. Furthermore, 
operations you perform on your mail in Mailstrom are reflected in 
other mail applications. For instance, if you delete messages using 
“Columbia mm,” a popular UNIX mail application, these messages will
not be available for later perusal in Mailstrom; the messages are 
expunged at the server. Currently, you cannot perform any write 
operations (operations that modify a message or a mailbox) on your 
mail from more than one application at the same time.  
The IMAP client/server model allows IMAP client programs to take 
full advantage of the client machine and to follow its user interface 
standards. Thus Mailstrom “looks and feels” like a Macintosh 
application, whereas the NeXT client program “looks and feels” like a 
NeXT program. For this reason, it should be relatively simple for a 
user who is acquainted with the Macintosh user interface to learn 
Mailstrom. 



Appendix C: Mailstrom Menus
These have not been updated since version b36 since they change 
with some frequency. This section will describe what each command 
does.







Appendix D: Keywords

A keyword is essentially a named flag which can be used to call 
attention to - or find a message. When assigned to a message, a 
keyword will precede that message in the browse window. For 
example, the keywords in the selected messages below are: Help and 
Meeting.

Keywords are definable by you. There are several ways of creating 
keywords and you can create as many keywords as you would like.

Creating Keywords
There are multiple ways to create keywords. The method described 
below is done within the Columbia mm mail program. The way that is 
described here is very simple and consists of editing the .mminit file 
through simple MM commands. You could also use emacs or another 
text editro to edit the .mminit file.
To edit the .mminit file:

1. Type mm at the UNIX prompt.

2. Type set keyword and the name(s) of the keywords set off by 
commas. 

CAUTION: Do not use a carriage return when you reach the end 
of a line. Doing this may prevent you from accessing your mail!

3. Type create-init

For example:
mm>set keyword HELP, MEETING, URGENT
mm>create-init

This creates the keywords: HELP, MEETING and URGENT.



Using Keywords in Mailstrom
After setting keywords in MM, you are able to attach keywords to 
messages.
1. Select the message(s) you wish to have marked with a keyword.
2. From the command bar select the Flag button, and from the 

resulting menu select the appropriate keyword(s). In the example 
below the keyword HELP is selected.

The message header in the browse window then looks like this:

Keywords can be removed by selecting toggling the arrow next to the 
keyword in the flag submenu. 



Appendix E: Editing Mailstrom’s Resources

Following the Apple Interface Guidelines, Mailstrom stores virtually 
all of its text, pictures, icons, menus, etc. in the resource fork of the 
application. This can be edited by the end user without any alteration 
of the source code, to change the appearance or even the functionality
of the program.
CAUTION: This may be too involved for the novice user, and the 
results of deleting resources may be to destroy the program.
This editing is done via a program called ResEdit, available from 
Apple Computer and shipped with many development tools, but 
instructions are included here for three changes that may be 
desirable, depending on your personal taste, or lack thereof.  We ask 
that you DO NOT DISTRIBUTE ANY VERSION OF MAILSTROM 
WHICH HAS BEEN EDITED.
If you are interested in this process, and want to make all of your Mac
applications behave differently than the documentation describes, we 
direct you to ResEdit Reference,  Addison-Wesley Publishers, 1991, 
available from APDA.

To change the "You have new messages" Sound
1) Make a backup copy of Mailstrom.

2) Launch ResEdit

3) Open Mailstrom with ResEdit.  You will see a window showing all 
of the resources contained in the application.



4. Double click on the icon labeled "snd".

5. Select the sound labeled ID 128.



6. Select Clear from the Edit menu.

7. Open the file containing your new sound.

8. Copy

9. Paste the new sound into the snds window of Mailstrom

10. Select Get Resource Info (cmd-I) from the Resource menu.

11. Set the ID to 128.

12. Close the window.



To Change The Command Key For A Menu Item:
Repeat steps 1-3 above:

4. Double click on the icon labeled "MENU".

5. Double click on the menu containing the item to be changed.

6. Select the character in the box labeled Cmd-Key (lower right).



7. Type the desired character.
NOTE: Be sure not to leave more than one menu item defined with the
same key equivalent.  
You may also change the names, colors or position of any of these 
items without affecting their functionality, but the number following 
the pound sign (#) must remain the same.  
It is also conceivable that you could define your own additional menu 
for certain items by creating a new MENU resource and copying items
to it. For it to appear it the menu bar, you must add its resource ID to 
the MBAR resource of ID 1.
The only exception to the freedom to edit MENU resources is in the 
Windows menu, which Mailstrom edits dynamically, based on the 
status of open windows.  The text, color or command keys for the first 
three entries may be edited, but those items should remain in their 
current position.

To Change The String Which Prefixes Inserted Text Of A Reply:
Repeat steps 1-3 from above.

4. Double click on the icon labeled "STR#".



5. Double click on the string list labeled ID 1131.

6. Scroll down to the 23rd string.



7. Type the new string. Remember to include any desired spaces to 
separate the prefix from the actual text.  The default string shown
above ends in three spaces.



Appendix F: Troubleshooting

Read-Only Alert
This message may be encountered just after logging into your mailbox
with Mailstrom:

This usually indicates the following: a previously-started e-mail 
process already exists on the mailbox you have indicated. This could 
be caused by your Macintosh crashing during your last Mailstrom 
session, or by leaving another mail program, e.g., Columbia mm, 
running. 
The simple solution, in any event, is to kill the mail process. This can 
be done by using the UNIX ps -x and kill commands (or at the KSL, 
the kprocs command). Follow these instructions:

1. Establish a virtual terminal connection to your mail server.

2. At the UNIX prompt, type jobs. This should give you a list of the 
UNIX processes running on the server. For example:

CAMIS> ps -x
PID TT STAT  TIME COMMAND
27917 ?  IW    0:00 /usr/etc/imapserver -l -d
28699 p7 IW    0:00 -csh (csh)

3. Look for the process containing the imapserver program and the 
process ID associated with it (in the above example, 27917). 

4. Type kill PID (where PID is the process id).



Reading Large Messages
Occasionally you may receive a message that is so large (contains 
greater than 32 kilobytes of data)that Mailstrom may be unable to 
display the message in its entirety. You may get the following 
message:

In such cases you can save the entire message to a file on the 
Macintosh on which you’re working.

Opening Large Text Documents
If you try to open a text document containing 32Kb or more of data, 
you will get an error message like the one below.

The solution to this problem is to break the text document into several
parts, each of which is less than 32 kilobytes. If you wish to send the 
document, simply send the parts.
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